Introduction to
Microsoft Access 2013(CHAPTER-2)
Supermarkets use computers for storing lists of items, their prices, quantities available and quantities sold. Have you ever wondered how they store, manage and quickly retrieve data about so many products?
Your elders can book railway tickets online. Where is the data about trains, their timings and seat allocation stored?
How is it that when a person books a ticket, the reserved and the available seats are automatically shown?
If a person is asked to memorise such records, it will be an almost impossible task. To deal with such problems, data is stored and managed in a computer using databases.
Thesedays, large amounts of data are required to be stored at all the places such as hotels, hospitals, supermarkets, railway stations, airports and offices. In this chapter, we will learn more about database and its related terminologies.
[image: ][image: ]DATABASE AND DBMS
A database is an organised collection of related data so that it can be easily accessed, managed and updated.






Learning Objectives


To learn about:
· database and DBMS.
· advantage of a database.
· starting Microsoft
Access.
· creating a database in Access.
· components of a table in Access.
· tables in Access.
· different views of a table—design view and database view.
· add and delete records in a table.
· set and remove a primary key in a table.
· modify the table design.


 (
 
Did You Know?
The relational data 
model 
was invented by 
E.F. (Ted) 
codd 
in the year 
1970.
A language called 
SQL (Structured Query Language) 
can be used to work on any RDBMS.
)Users have limited rights and permissions. Only authorised users can access the data. Some may have the privilege of changing the data while others can only view the data.
 Maintaining Standards: A DBMS ensures that the stored data follows the organisation’s own standards or national/international standards.
This ensures greater data integrity.
This also aids in sharing data between different systems.

[image: ]
Microsoft Access is the most popular RDBMS that comes as a part of the Microsoft Office suite. Access provides a graphical user interface for managing data. The databases created in Access 2013 are saved with the extension
.accdb. Databases in Access 2013 are composed of four main objects—tables, queries, forms and reports. These objects allow us to enter, store, analyse and compile the data.
Let us learn more about these objects.

 (
Objects in Access
)




The main objects that can be created in Access are as follows.
Tables: They are used to store data in the form of rows (records) and columns (fields). A table is also referred to as a relation. We will learn more about tables in this chapter.
Queries: Query let us find and work on the










Fig. 2.1 Objects in Access

data resulting from one or multiple tables based on specified conditions.
Forms: Forms provide a user interface that lets the users enter and change data in the tables.
Reports: If forms are for input, then reports are for output. Reports are used to display the data stored in database tables in a professional format for printing purposes.
 (
Starting
 
Access
)
To start Access, type Access 2013 in the Search box and click on Access 2013
option. The Microsoft Access start up window opens as shown in Figure 2.3.

 (
Type access 2013 in the Search box
Click on Access 2013 option
)	
Fig. 2.5 Creating a database (Steps 2, 3 and 4)
[image: ]

Follow the given steps to create a blank database in Access.
 (
Step 1
)Click on the Blank desktop database option.
 (
Step 2
)Type a name for the database in the File Name textbox.
 (
Step 3
)Click on the Browse button next to the File Name textbox and choose a location for the database.
 (
Step 4
)Click on the Create button. A blank database gets created. Access creates the database with an empty table named Table1. We will learn about working with tables after familiarising ourselves with the various components of the Access window shown in Figure 2.6.








   Step 1 


Fig. 2.4 Creating a database (Step 1)






 (
   Step 2 
) (
   Step 3 
)









   Step 4 



Fig. 2.5 Creating a database (Steps 2, 3 and 4)






Fig. 2.6   A new database with a blank table
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Let us get familiar with the various components of the Access window
(Fig. 2.7).
 (
 
Quick Access
 
Toolbar
 
Title bar 
 
 Object tabs 
 
 Navigation pane 
 
 Work Area 
 
 Navigation buttons 
 
  View buttons 
Ribbon
)
Fig. 2.7   Access window

[image: ]Title Bar: The Title Bar appears on the top of the window and displays the name of the document on which you are currently working.


 (
Quick Access Toolbar
) (
:
)The Quick Access Toolbar is present on the top left corner of the Access window. It has buttons for commands that are used frequently. By default, the following buttons are present on it.
1. Save button: to save your work
2. Undo button: to undo the previous action/rollback the action done
3. Redo button: to redo the action that was undone.
We can customise the Toolbar and add more buttons to it by clicking on the arrow next to the Redo button.
[image: ]Ribbon: The Ribbon contains multiple tabs, each with several groups of commands. Some tabs appear only when you work with certain objects such
as Forms. These tabs are called contextual tabs.
 (
Navigation
 
Pane:
)The Navigation pane displays the names of all the objects in the database. The objects are grouped on the basis of their type, for example, Tables, Queries and so on. We can double-click
on an object name in the Navigation Pane to 
 (
Click on the arrow to minimise the Navigation pane
)













open it. We can right-click on an object in the Navigation pane to perform various operations such as renaming and deleting an object.







 (
 
TIPs and
 
TRICKs
Click the
 
double
 
arrow
in the upper- right corner of the Navigation Pane to minimize it. 
To 
make the Navigation Pane visible again, click the
 
double
 
arrow
to 
maximize
 
it.
)Fig. 2.8 Navigation Pane

 (
Navigation
 
Buttons
) (
:
)The Navigation buttons display the current record number in an object (in this example, Tables Employee) on which you are working. It has buttons to move back and forth between the various records.
 (
Object
 
Tabs:
)The objects that you have opened in a database appear in a tabbed form. When you click on an object tab, the contents of that object are displayed in the Work Area. Click on the cross button (X) on the right end of the bar to close the object displayed in the current tab.


[image: ]Status Bar: The Status bar appears at the bottom of the window. The view
buttons	are present on the right side of the Status bar.  Usually
two common buttons that are present are Datasheet view and Design view.

[image: ]
The tables are the building blocks of a database and are used for storing data. A table is made up of rows and columns. A database can have one or more tables.
Consider the following table that stores data about the employees in an organisation.
 (
 
 
Primary key
   Field or Attribute 
)Table 2.1 Information about employees in an organisation

	Eno
	Ename
	Esalary
	Eaddress

	1
	Harish
	10000
	12-Park Street, New Delhi

	2
	Ramesh
	25000
	Flat No. 5, Vikas Apartment, Rohini, New Delhi
Record

	3
	Kiran
	7500
	23/78, Hari Ganj, New Delhi

	4
	Harshita
	12000
	C-1/2 Rising Sun Apartments, Paschim Vihar, New Delhi





 (
Components 
of 
a
 
Table
)
The important components of a table are:
1. [image: ]Field or Attribute: The columns in a table are known as fields or attributes. A field is a named unit of information. A field stores one type of information
about all the objects or items. Every field has a data type that determines the type of values that can be stored under it. For example, the above table has four fields or attributes. The field Ename stores text values and the field Esalary stores numeric values. Let us learn more about field data types.
Field Data types
The various data types available in Access are given in Table 2.2.

	Data Type
	Description

	Short Text
	The fields with Short Text data type can store text or a combination of text and numbers such as names, addresses and postal codes. The fields with this data type can have a maximum of 255 characters.

	Long Text
	The fields with Long Text data type can store lengthy texts, that is, up to 65,536 characters. It can be used for storing detailed information such as synopsis of a book or a patient’s medical history.

	Number
	The fields with this data type can store numbers.

	Date/Time
	The fields with this data type can store date and time values.

	Currency
	The fields with this data type can store currency v
alues and then display
them in different formats.

	Autonumber
	The fields with this data type store integers that are incremented
automatically when a new row or record is added to a table.

	Yes/No
	The fields with this data type can store only one of the two possible values such as Yes/No, True/False or ON/OFF.

	OLE Object
	The fields with this data type can store files such as Word document, excel
file and so on.

	Hyperlink
	The fields with this data type can store links to websites or email
addresses.

	Attachment
	The fields with this data type can store files. For fields with this data type,
multiple files can be attached per record.

	Calculated
	The fields with this data type store results of a calculation.

	Lookup Wizard
	This wizard creates a lookup field that displays a set of values.















	


Table 2.2   Data types in Access


After setting the data type for a field, we can set its properties. Let us learn more about field properties.
Field Properties
After we have decided on the data type of the table, we can set field properties. The Field properties let us have more control on data that can be entered in a particular field. Some of the field properties are listed in Table 2.3.


	Field Size
	This property can be set for fields with Short Text or Number
data types.
· For Text data types, you can use this property to set
the maximum number of characters for a text field. For example, if the value of this property is 20, then the user cannot enter more than 20 characters in the field. The default value for Field Size property is 50 for the Text data type.
· For Number data types, the user can choose from one of the following options—Byte, Integer, Long Integer, Single, Double and Decimal. These options determine the range of values and size of the field.

	Format
	This property controls the manner in which data gets displayed. For example, for Date and Time data types, you can choose the different styles of displaying date and time such as Long Date (Thursday, June 13, 2013) or Short Date
(6/13/2013).

	Decimal Places
	This property is valid for Number and Currency data types. It
is used to specify the number of digits to be displayed to the right of the decimal point. Its value may vary from 1 to 15.

	Caption
	This property is used to give an alternate, more descriptive
name to a field.

	Default Value
	This property is used to specify a value that gets displayed
automatically when the records are created.

	Validation Rule
	This property is used to put conditions on the data that can be entered in a field. You cannot enter a value if it is not according to the validation rule. Examples of Validation rules
are:

	
	Validation Rule
	Description

	
	>=0
	Value in the field must be
greater than or equal to zero

	
	Between 10 and 20
	Value in the field must be
between 10 and 20

	
	=“Delhi”
	Value in the field can only be
Delhi

	
	In (“Delhi”, “Mumbai”)
	Value in the field can be Delhi
or Mumbai





























	Validation Text
	This property is used to display an error message when the
validation rule gets violated.

	Required
	This property can have only two values—Yes or No. It should
be set to Yes if you want that a particular field should always get a value during the data entry.

	Allow Zero Length
	This property is available for fields with Short Text and Long Text data types. It can have two values—Yes or No. If the Required property is set to ‘Yes’ and the Allow Zero Length property is set to ‘No’, then a value must be entered in the
field.


Table 2.3   Field properties in Access

2. [image: ]Record: The rows in a table are known as records. A record stores complete information about an object or an item. For example, Table Employee
(Table 2.1) has four records. Each record contains the complete information about an employee.

3.  (
Primar�
 
key:
)	A primary key is a field or combination of fields that uniquely identifies the records in a table. A primary key field cannot have repetitive values and cannot be left blank. In Table 2.1, Eno field can be made the primary key as every employee has a unique employee number.
 (
Views 
of 
a
 
Table
)
We can work on a table in two views—Design view and Datasheet view. Let us learn more about them.
 (
Design view
)


In the Design view of the table, you can enter the field names, their data types and description. You can also set the field properties. The Design view window is divided into two panes—
1. Field Grid Pane: Field Grid










 (
 Field Grid Pane 
Field Properties Pane
)Fig. 2.10 Design View of a table

Pane is used for entering field names and their data types. You can also give an optional description about each field in this pane.
2. Field Properties Pane: Field Properties Pane is used to set properties for the fields in the table.

 (
Datasheet view
)
You use the Datasheet view to enter data in the table. When you double-click the table name in the database window, the table opens in the Datasheet view.
[image: ]
Fig. 2.11   Datasheet View of a table

 (
Switching 
bet�een 
Views
)
You can quickly switch from one view to another by following either of the two options:
[image: ] (
Design view
Datasheet view
) Click on the View option in the Views
group on the Home  tab to change to the	a)	b)

desired view.

Fig. 2.12 Switching between views
OR


[image: ][image: ]  Click  on  the Design view	or Datasheet view	buttons at the
bottom-right corner of the Status bar.

[image: ] (
 
TIPs and
 
TRICKs
Double-clicking on the table name in the Navigation Pane opens the table in the Datasheet view by default.
)
There are various ways to create tables in Access. In this chapter, you will be learning to create tables in the Design view. This view lets you design the structure of a table by specifying the field names, their data types and properties.

The steps to create a table in the Design view are:
 (
Step 1
)Click on the Create tab.
 (
   Step 1 
   Step 2 
Fig. 2.13 
Creating table in Design View (Steps 1 and 2)
) (
Step 2
)Click on the Table Design option in the Tables group. A new table is inserted in the database and it opens in the Design View. A new tab named Design appears in the Ribbon.

 (
Step 3
) (
Step 4
) (
Step 5
)Enter the name for the field in the Field Name column. Choose a Data Type for a field from the Data Type list.
Use the Field Properties pane to set the properties for the fields.
 (
   Step 4 
   Step 3 
Step 5
Step 6
)Repeat steps 3 to 5 for all the fields in the table.
Fig. 2.14 Creating table in Design View (Steps 3 to 6)
 (
Step 6
)Place the cursor on the field to be set as the Primary key and click on

 (
32
) (
Primary key
)the Primary Key option	in the Tools  group on the Design  tab. You
[image: ]will notice that a key symbol	appears next to the field.
Fig. 2.14 Creating table in Design View (Steps 3 to 6)
 (
Step 6
)Place the cursor on the field to be set as the Primary key and click on

 (
Primary key
)the Primary Key option	in the Tools  group on the Design  tab. You
[image: ]will notice that a key symbol	appears next to the field.

 (
Step 7
)Click on the Save button on the Quick Access toolbar or Click on the File tab and choose the Save option. Save the table with an appropriate name.
The table object is now added to the Navigation Pane.

 
                                                 (
A table named 
Student 
gets added to the database
)

 (
   Step 7 
)
Fig. 2.15 Creating table in Design View (Step 7)

[image: ][image: ][image: ]
After creating the table in the Design view, we can add records to it in the Datasheet view. The steps to enter records in a table are as follows:
 (
Step 1
)Open the table in the Datasheet view. (Double-click on the table in the Navigation Pane to open it in the Datasheet view)
 (
Step 2
)Click on the New option in Records group on the Home tab. A new record is inserted in the table.
 (
Step 3
)Type the values for various fields in a record.
When you start entering data, a new record gets inserted automatically at the end of a table.
 (
   Step 2 
   Step 3 
Fig. 2.17 
Adding Records in a table
   Step 1 
)





	Field Name
	Data Type
	Field Properties

	Book_No
	AutoNumber
	Primary Key

	Book_Name
	Short Text
	Field Size=40

	Book_Price
	Number
	Field Size=Single

	Book_Publisher
	Short Text
	Default Value = “Pearson”




 (
Computer Book 8.indb 
36
) (
27/09/2016 16:30:04
)




	Book_Category
	Short Text
	Validation Rule= Value can only be “Fiction”
or “Autobiography”
[Hint:
IN(“Fiction”, “Autobiography”)
Validation Text:= “Enter Appropriate Category”

	Book_Synopsis
	Long Text
	Required=”Yes”, Allow Zero Length=”No”





[image: ][image: ]DELETING RECORDS IN A TABLE
Open the table in the Datasheet view and follow these steps to delete a record.
 (
Step 1
)Select the record that needs to be deleted.
 (
Step 2
)Click on the Delete option	in the Records group on the Home
tab.
 (
   Step 2 
   Step 1 
)
Fig. 2.18   Deleting a Record in a table
 (
TIPs and TRICKs
To delete or rename a table, right-click on the table in the Navigation Pane and choose
the 
Delete 
or 
Rename 
option.
)

[image: ][image: ][image: ]SORTING RECORD IN A TABLE
Open the table in the Datasheet view and follow these steps to sort records.
 (
Step 1
)Select the field on the basis of which you want to sort the records.
 (
Step 2
)Click on the Ascending or Descending option in the Sort & filter group on the Home tab. The records get sorted.

 (
   Step 2 
   Step 1 
)
Fig. 2.21 Inserting a new field in a table (Steps 1 and 2)
 (
New field in the table
)
Fig. 2.22   New field inserted
 (
Deleting 
a
 
Field
)
Open the table in Design view and follow the given steps to delete a field in the table.
 (
Step 1
)Click the field that has to be removed.
 (
Step 2
)Click on the Delete Rows option in the Tools group on the Design tab.
 (
Step 3
)Before permanently deleting a field, Access displays a warning box confirming whether you want to delete the field permanently. Click on the Yes button.
The field is deleted from the table.

[image: ]
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